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Al-ISRA PRIVATE UNIVERSITY 

FACULTY OF INFORMATION TECHNOLOGY 

 (Revised March 2007) 
PREFACE
ISRA Private University (IPU) started its Faculty of Information Technology (FIT) in the year 2000-2001. Within a short span of time, it has emerged as one of the leading IT Faculties in the Kingdom. This handbook contains a compact and precise summary of all the necessary information pertaining to Labs of FIT. 

FIT has an IT-intensive environment with state-of-the-art infrastructure and high-speed network for staff and students to access electronic applications and services for their work and study. 

FIT has a number of labs consisting of most modern devices. All these labs are networked for the ease of meeting the learning objectives
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Always: 
 --Wait for the previous class to leave before the next class enters 

 --Log off when finished (Shut down only at 9:50PM) 

 --Return lab manuals 

 --Wrap wire neatly around headphones 

 --Ask the teacher or the lab assistant if you don’t understand 
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Never: 
 --Eat, drink, smoke, or chew gum in the lab 

 --Enter the lab assistant’s area 

 --View pornography from the internet 

 --Check personal email, unless course-related 

 --Install new software on the lab computers 

--Turn off computer equipment, except to shut down at night 

--Use cell phones or converse loudly in the lab 
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You Can: 
 --Use a black plastic glare hood for better light reflection 

 --Adjust the chairs up and down with the right-side lever 
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PARTS OF A COMPUTER
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	Lab Name/ Lab #
	Quantity
	Hardware
	Software
	Extension
	Lab Assistance

	4003
	20
	PCS (2.8 GHZ, 80 GB HDD, 256 MB RAM, 52 X CD ROM).
	Windows XP SP2, Office 2003,  Visual Basic 6,  Turbo C, MASM
	2521
	Ahmad Hasan Ahmad “Hussein AL-Ali”

	
	1
	SUPERVISOR PC (2.8 GHZ, 80 GB HDD, 512 MB RAM, 52 X CD ROM).
	
	
	

	
	1
	Epson LQ-2180.
	
	
	

	
	1
	HP Laser Jet 1320
	
	
	

	
	1
	Data Show
	
	
	

	
	1
	UPS 
	
	
	

	
	1
	SCANNER
	
	
	

	
	1
	LG  WRITTER
	
	
	

	4315
	20
	PCS (2.8 GHZ, 80 GB HDD, 256 MB RAM, 52 X CD ROM).
	Windows XP SP2, Office 2003,  Visual,  Turbo C, JSDK 1.5, .NET 2003, MASM, Prolog, Emulator
	2485
	Mahmoud Jamil Mahmoud Khader

	
	1
	SUPERVISOR PC (2.8 GHZ, 80 GB HDD, 256 MB RAM, 52 X CD ROM).
	
	
	

	
	1
	Epson EPL-6100 Laser Printer .
	
	
	

	
	1
	DOT – MATRIX PRINTER (Epson LQ 2180)
	
	
	

	4319
	22
	PCS (2.8 GHZ, 80 GB HDD, 512 MB RAM, 52 X CD ROM).
	Windows XP SP2, Office 2003,  Visual C, JSDK 1.5, .NET 2003, MASM, Prolog, Emulator , Oracle 9i
	2526
	Mohammad Khalil Ahmad Hammodeh

	
	1
	SUPERVISOR PC (2.8 GHZ, 80 GB HDD, 256 MB RAM, 52 X CD ROM).
	
	
	

	
	1
	Epson EPL-6100 Laser Printer .
	
	
	

	
	1
	DOT – MATRIX PRINTER (Epson LQ 2180)
	
	
	

	
	1
	Epson 1250 Scanner
	
	
	

	
	1
	Data Show
	
	
	

	
	1
	LG DVD Rewriter External
	
	
	

	
	1
	LG CD-RW/DVD-ROM  External Drive
	
	
	

	
	1
	Server Intel XEON PC(2.0 GHz, 80 GB HDD, 1.0 GB RAM)
	
	
	


Department LABS

	Lab Name/ Lab #
	Quantity
	Hardware
	Software
	Extension
	Lab Assistance

	4321
	19
	PCS (1.8 GHZ, 40 GB HDD, 256 MB RAM, 56 X CD ROM).
	Windows XP SP2, Office 2003,  Visual,  Turbo C, JSDK 1.5, .NET 2003, MASM, Prolog, Emulator
	2524
	Abed Elkader Adel Saaed Zayed

	
	2
	PCS (2.8 GHZ, 80 GB HDD, 256 MB RAM, 52 X CD ROM).
	
	
	

	
	1
	SUPERVISOR PC (2.8 GHZ, 80 GB HDD, 512 MB RAM, 52 X CD ROM).
	
	
	

	
	4
	SERVER PCs(200 MHz, 2 GB HDD, 64 MB RAM, 52X CD ROM)
	
	
	

	
	1
	Epson EPL-6100 Laser Printer
	
	
	

	
	1
	DOT – MATRIX PRINTER (Epson LQ 2180)
	
	
	

	
	1
	Epson 1250 Scanner
	
	
	

	
	1
	HP Desk Jet 1280 Printer
	
	
	

	
	1
	HP PRINTER LASER JET 1320
	
	
	

	
	1
	LG CD-RW/DVD-ROM External Drive
	
	
	

	
	1
	DATA SHOW
	
	
	

	4336


	20
	PCs (3.0 GHZ, 80 GB HDD, 256 MB RAM,    52X CD ROM).
	Windows XP SP2 , Office 2003, Visual Basic 6, .NET 2003, Rational, JSDK 1.4, Turbo C, Prolog, Macromedia flash MX  6.0
	2514
	Yasser Mohammad Kahled Haswah

	
	1
	SUPERVISOR PC (3.0 GHZ, 80 GB HDD, 256 MB RAM,    52X CD ROM).
	
	
	

	
	1
	DOT – MATRIX PRINTER   Epson LQ 2180
	
	
	

	
	1
	EPSON EPL 6100


	
	
	

	3310


	20
	PCs (1.8 GHZ, 40 GB HDD,256 MB RAM 56x CD-ROM)
	Windows XP SP2 , Office 2003, Turbo C, Visual Basic 6.0
	2305
	Ahmad Mohammad Ahmad Mansour

	
	1
	PC (1.4 GHZ, 40 GB HDD,128 MB RAM 52x CD-ROM)
	
	
	

	
	1
	PC (1.4 GHZ, 40 GB HDD,128 MB RAM 52x CD-ROM)
	
	
	

	
	1
	DOT – MATRIX PRINTER .(Tally)
	
	
	

	3311
	20
	PCs (1.8 GHZ, 40 GB HDD,256 MB RAM 56x CD-ROM)
	Windows XP SP2 , Office 2003, Turbo C, Visual Basic 6.0
	2305
	Emad Jamil Nassar

	
	1
	PC (1.4 GHZ, 40 GB HDD,128 MB RAM 52x CD-ROM)
	
	
	

	
	1
	SUPERVISOR PC (1.4 GHZ, 40GB HDD, 128 MB RAM, 52X CD ROM)
	
	
	

	
	1
	HP LASER JET 5N PRINTER.
	
	
	

	
	1
	DOT – MATRIX PRINTER .
	
	
	


	Lab Name/ Lab #
	Quantity
	Hardware
	Software
	Extension
	Lab Assistance

	2332


	19
	PCS (1.8 GHZ, 40 GB HDD, 256 MB RAM, 56 X CD ROM).
	Windows XP, Office 2003, Visual Basic 6, Turbo C, JSDK 1.4.
	2433
	Malik Ibrahim Khalil Hdaib

	
	2
	PCs ( 1.4  GHz, 40 GB HDD, 128 MB RAM, 52x CD ROM)
	
	
	

	
	1
	SUPERVISOR PC (1.8 GHZ, 40 GB HDD, 256 MB RAM 56X CD ROM).
	
	
	

	
	1
	DOT – MATRIX PRINTER . 
	
	
	

	1127
	21
	PCS (1.8 GHZ, 40 GB HDD, 256 MB RAM, 56 X CD ROM).
	Windows XP SP2, Office 2003, Visual Basic 6, Turbo C, JSDK 1.4.
	2326
	Alaa ALDeen Mustafa Nofal

	
	1
	SUPERVISOR PC (1.8 GHZ, 40 GB HDD, 256 MB RAM 56X CD ROM).
	
	
	

	
	1


	DOT – MATRIX PRINTER   Epson LQ 2180
	
	
	

	
	1
	LASER PRINTER     (HP LASER 5N)
	
	
	

	2222


	8
	PCs (3.0 GHZ, 80GB HDD, 256 MB RAM, 52X CD ROM)
	Windows XP SP2, Office 2003,VISUAL BASIC 6.0, PHOTO SHOP 8.0, 3D max, Auto cad Adobe Premiere pro
	2413
	Jehan Saleem Mohammed Rasheed

	
	1
	SUPERVISOR PC (3.0 GHZ, 80 GB HDD, 256 MB RAM, 52X CD ROM)
	
	
	

	
	1
	PC (700 MHZ, 20 GB HDD, 128 MB RAM, 56X CD ROM)
	
	
	

	
	1
	PC (700 MHZ, 40 GB HDD, 32 MB RAM)
	
	
	

	
	1
	PC (700 MHZ, 1.7 GB HDD, 128 MB RAM)
	
	
	

	
	1
	PC (700 MHZ, 20 GB HDD, 64 MB RAM, 52X CD ROM)
	
	
	

	
	1
	PC (1.4 GHZ, 40 GB HDD, 128 MB RAM, 52X CD ROM)
	
	
	

	
	1
	LASER JET 4 PLUS .
	
	
	

	
	1
	DATA SHOW
	
	
	

	2226
	9
	PCs (700 MHZ, 20 GB HDD, 64 MB RAM)
	Windows 98 SECOND EDITION , Office 97,

Windows XP SP2

Windows 98 SECOND EDITION , Office 97,
	2413
	Hassan Husein Darwish

	
	7
	PCs (700 MHZ, 1.6 GB HDD,  64 MB RAM)
	
	
	

	
	1
	SUPERVISOR PC (1.4 GHZ, 40GB HDD, 128 MB RAM, 52X CD ROM)
	
	
	

	
	1
	PC (700 MHZ, 10 GB HDD,  64 MB RAM, 52X CD-ROM)
	
	
	

	
	1
	PC (700 MHZ, 4 GB HDD,  64 MB RAM, 52X CD-ROM)
	
	
	

	
	1
	PC (700 MHZ, 8 GB HDD,  96 MB RAM)
	
	
	

	
	1
	PC (700 MHZ, 12 GB HDD,  64 MB RAM)
	
	
	

	
	1
	DOT-MATRIX PRINTER (TALLY)
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RESOURCES
 Servers 

To better support and manage the campus wide spectrum of teaching, research and administrative activities, a diverse range of major network servers are set up for different systems and applications. Some of the major network servers include Internet, Thin Client, Web, Multimedia, File, Backup, Print, Database, and Access control servers. 

 Services 

1. Unlimited access to the PCs and to the thin client terminals within the University working hours. 

2. Unlimited access to Internet. 

3. Self-learning opportunities. 

4. Technical and help support directed by the labs supervisors. 

5. Downloads of freeware or trial ware utilities that might be useful for research or for any useful purpose can be allowed with prior permission of lab supervisor. 

6. Organized access to some material resources such as printers and data storage locations is provided. 

7. Any new software installations or upgrades can be achieved through the permission of lab supervisor. 

Faculty staff members and students are also to note that they are to comply strictly with the ethics guidelines (listed below) in the usage of the account. 

For quick assistance, users can refer to helpdesk center as detailed below: 

	Domain 
	Contact Persons 
	Lab Number 

	Networks 
	Mahmoud Jamil, Mohammad Hammodeh
	4315,4319

	Rational 
	Yasser Haswah, Ahmad Mansour
	4336,3310

	Internet + Maintenance 
	Yasser Haswah, Mohammad Hammodeh, Malik Hdaib
	4336,4319,2332

	Linux + UNIX "Solaris" 
	Mahmoud Jamil
	4315

	Applications 
	Ahmad Hasan, Mohammad Hammodeh, Alaa Nofal
	4003,4319,1127

	Applications + Maintenance 
	Abed Elkader Zayed, Mohammad Hammodeh,

Ahmad Hasan
	4321,4319,4003

	Phoenix " Cyberlearning " 
	Mohammad Hammodeh
	4319

	ICDL 
	Abed Elkader Zayed, Jehan Saleem , Emad Nassar, Hassan Darwish
	4321,2222,3311,
2226


Return to table of contents
Anti-Virus Support 

With the recent spate of computer viruses attacks, computer centre recognizes that it is important to secure users and resources on some of the most popular means of virus propagation and preventive measures to prevent its onslaught. In this connection, FIT has the latest anti-virus supports, and by using server based solutions the resources are protected against viruses. 
Return to table of contents
FTP Software Archives 

FTP stands for “File Transfer Protocol”. A protocol is a language that enables computers to speak to one another. FTP is used to make files and folders publicly available for transfer over the Internet. Servers in FIT have compiled a list of popular FTP software archives sites for users to download. Users can work with files and folders on the FTP servers much as like you work with them on your own computer. One can view, download, upload, rename, and delete files and folders.
Return to table of contents
File and Print Services 

File server provides a central repository for application software in the areas of: 

· Word processing 

· Web browsers 

· Client/Server applications 

· Spreadsheets 

· Graphics packages 

· Statistics packages 

· Desktop publishing 

· Presentation software 

· Language compilers 

· Computer-based learning 

· Anti-virus software 

Network printing facilitates sharing of high quality laser and postscript printers. Users are allowed to share networked printers with a choice of printers, dot matrix or laser, to print their documents. 

Best Practice Standards 

Purpose/Scope 

The following guidelines set the best practice standards for appropriate behavior for FIT staff members and students when accessing computer networks. 

General 

· Users are individually responsible for understanding and respecting the security policies of the resources (computers and networks) they are using. Users are individually accountable for all activities that are conducted via their accounts including, but not limited to electronic mails, newsgroup postings and uploading/downloading of information to/from Internet respectively. 

· Users have the responsibility to employ available security mechanisms and procedures for protecting their own data among which is to employ a good password and safeguard their data from being stolen or tampered with. 

· Computer and network administrators are responsible for maintaining the security of the systems they administer. System developers and implementers are responsible for providing or developing systems, which are sound and secured, which embody adequate security controls in accordance with PU security guidelines and policies. 

· One must comply with rules appropriate to the network's netiquette should one use another organization’s network or computing resources. 
Return to table of contents
Guidelines for using services

Electronic Mail 

· E-mail on Internet is not secure unless encryption is used. Never include in an e-mail message anything, which you want to keep private and confidential. 

· Always use real username and node when sending e-mail. Do not masquerade or send mail anonymously. 

· Mass-mailing is prohibited. Always obtain permission from computer center if you wish to send e-mail to more than 20 persons locally, unless you are authorized to send such mails. 

· Use the "Reply to All" option with care when replying to any mail received, to prevent inadvertently sending out mass mails. 

· Never participate in any mail requesting for donations or "get-rich" schemes. 

· Always use appropriate and meaningful subject header in all your mails to reflect accurately the content of your mail. 

Internet Mailing Lists and Usenet News Groups 

· Actively disclaim speaking for FIT if you are not. Note that if you use a FIT system to send an e-mail, the name of PU is carried along with what you send in (at least) the headers. 

· Obey copyright laws and indicate quoted laws materials. 

· Do not post any messages anonymously or cross-post the same messages to more than 5 newsgroups. 

· Always post the correct message to the correct newsgroup. 

· Use discussion groups for discussion topics. 

FTP 

· Look locally before ftping something from a geographically remote site. 

· Observe any posted restrictions on the ftp server. 

· Obey copyright laws when uploading or downloading any files. 

· Do not upload any files confidential to PU. 

· Always scan any downloaded file (software or document) for virus. 

World-Wide-Web 

· Do not download or publish any objectionable information. 

· Do not submit or publish any information confidential to FIT without prior approval. 

Telnet 

· Do not telnet to machines on which you have no account, or there is no guest account. 

· Observe any posted restrictions on machines to which you telnet to. 

· Do not use the same password that you use for the corporate systems. Passwords are transmitted in the clear text and are easily captured. 

· You are encouraged to access the systems over a secured channel. 

Desktop 

· DO NOT leave your sessions in computer clusters unattended for more than 10 minutes. 

· Always scan diskettes before using them. 

· Make frequent backups of the data stored in the hard disk. 

· In case of running sensitive applications, ensure that the computer is in a physically secure location. 

· Try not to store any confidential/important documents without protecting them. 

· If necessary, encrypt the data in storage. 

Passwords 

· DO use a password with mixed-case letters. Do not just capitalize the first letter, but add uppercase letters in the middle. 

· DO use a password that contains alphanumeric characters and include punctuation. 

· DO use a password that can be typed quickly, without having to look at the keyboard. This makes it harder for someone to steal your password by looking at your keyboard. 

· DO change your password every six months. 

· DO NOT use your User Id in any form (as-is, reversed, capitalized, doubled, etc) as the password. 

· DO NOT use your first, middle or last name in any form. Do not use your initials or any nicknames you may have. 

· DO NOT use your spouse's or child's name. 

· DO NOT use a word contained in english or foreign dictionaries, spelling lists, or other word lists. 

· DO NOT use other information easily obtained about you. This includes license plate numbers, telephone numbers, identification numbers, the brand of your automobile, the name of the street you live on, etc. 

· DO NOT use a password of all numbers, or a password composed of the same alphabet. 

· DO NOT write your password on desk blotters, calendars, or store it on-line. 

· DO NOT reveal your password to anyone. 

Return to table of contents
Getting Started

Log On And Getting To The Desktop 

 Begin by pressing the keys Ctrl-Alt-Delete. This is the first step when using any PC/Microsoft-based computer. Push down each key in order and hold it down, then release

When students have successfully logged on, they will reach the blue-screened “desktop” with the Windows Start icon in the lower-left corner. They are now ready to open whatever program the lesson requires. Some programs, particularly MS Word and Internet Explorer, may also be on the desktop, ready to open without going through the Start icon. 

Return to table of contents
Opening A Program 

 A one-page set of step-by-step instructions for opening the Ainsworth Keyboard Trainer, Focus On Grammar, and Microsoft Word programs are found in Sections V, VI, and VII of this manual. 

 In general, to open a program you double click on its icon. Some programs, particularly Internet Explorer, may be located on the desktop. Most, however, are located by clicking on the Windows Start icon, then Programs, then double clicking on the program you want to open: 

 Start—Programs—Microsoft Office—MS Word 
Return to table of contents
Log Off, Restart, Shut Down 

 When you finish working, never turn off the power to the computer. Instead, use the “Shut Down” or “Log Off” function under the Windows Start icon. There is also a “Restart” option under the Shut Down function. If you are in night class and the lab is closing for the day, you may be asked to use Shut Down. Otherwise, use Log Off to ready the computer for other students. Ordinary procedure: 

Start—Log Off—Log Off   or   Start—Shut Down—Log Off—Log Off 
If The Computer Stops Working 

 With PC computers, a useful procedure when you can’t resolve a problem or when the computer “freezes” is to simply start over again. Press the three keys, Ctrl-Alt-Delete in quick succession, and the programs will close and take you back to the desktop. You will, however, lose any work you have done. 

Return to table of contents
BASIC TECHNIQUES 
Using A Mouse 

 The mouse and the keyboard are used to input instructions and data. Some mouse functions can also be done with the keyboard, but beginners probably find it easier to use the keyboard for inputting letters and numbers and the mouse for all other functions. 

 Grip the mouse with the buttons and the wire to the computer pointing up. Get used to moving it around the screen to different locations, and notice that you can pick it up and set it back down to continue rolling it in a small space. 

 The mouse is used to open and close programs and windows, to select functions like Save and Print, to “scroll” up and down a document, and to change font size, style, margins, spacing, etc. 

 There are several “mouse techniques” for accomplishing different functions. All of them require you to move the mouse to an icon or a line of text and point at it. Most of them use the left-side button only: 

 Double clicking. This is used most commonly when opening a program or other icon. You click the button twice, quickly, while pointing to the icon of the function you want to carry out. Example: To open Internet Explorer, point to the big blue “e” and click twice. If you double click too slowly, the icon will highlight but not open, as if you clicked only once. Then you have to single click again, or press the “Enter” key on the keyboard, to un-highlight it before you can try again to open it. 

 Single clicking and highlighting. This is usually done to select options after double clicking on an icon. You point to another icon or line of text and click once. Sometimes this will “highlight” an item, making it darker. You can then select from the menu to do something with the item, such as move it to another place. If you make a mistake, you can un-highlight an item by clicking it again. Other times the arrow that points to the selection will turn into a finger shape when it is ready to click, and the computer will carry out a command. 

 Dragging. The borders of a window can be enlarged, and some items can be moved, by dragging. You click the mouse at the edge or corner of the item, then hold the left button down until you move it to the desired location, and release.  

 Selecting/Highlighting. Similar to dragging, this is most commonly done when you want to copy a section of text or part of a graphic image. You point the mouse at the edge of the item to select, then hold the left button down until the section you want to copy turns dark. Then release the button. This takes some practice, and you can cancel if you make a mistake by moving the mouse away from the section and clicking again. 

 Scrolling. A very common use of the mouse when reading from the screen is to use the vertical line at the right of the document, called the “scroll bar”, to move up or down the lines of text. You can click in the middle square and move up or down rapidly, or you can click in the arrowed boxes at the top or bottom of the document and move up or down slowly. 
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Using The Keyboard 

 The concept of “home keys” is essential to typing by touch. The home keys are: 

 a s d f   and  j k l ; 

 You place the four fingers of your left hand on a-s-d-f, and the fingers of your right hand on j-k-l-;, and move the fingers from these home locations to the other keys. Numbers are located above the letter keys, and most  punctuation marks (; : ‘ “ , . ?) are found in the lower right corner. 

 Upper and lower case. There is a Shift key on both sides of the keyboard that you hold down with your end fingers to capitalize a letter, and a “Caps Lock” on the left side that you can press once to make all letters capitals. Press it again to release it. Remember that some computer input is “case sensitive”, meaning you must use capital or small letters for the instructions to work. 

 Space bar. The long bar at the bottom of the keyboard, you press it with your thumbs to make spaces between words. 

 Backspace key. You use this to move “backwards” over a short distance. It erases any letters it passes over while backing up, and therefore is a convenient way to correct mistakes. 

 Insert key. This key, to the right of the main keyboard near the backspace key, is sometimes hit by mistake. It causes new text to be inserted over the old text, erasing the old text as you type. This is seldom a useful function for beginners, and you can cancel the function if you hit it by mistake by simply pressing it again. 

 Enter key. The two main functions of the Enter key are (1) to skip to a new line of text, and (2) to execute a command with the keyboard instead of by clicking with the mouse. When writing with a word processing program, remember: You don’t need to press Enter at the end of each line, because the program does it automatically. You use it only when you are starting a new paragraph, or intentionally writing short lines such as in a list. 

 Tab key. Located in the upper left corner of the keyboard, you use it to indent a paragraph. 

 Cursors. Located in the lower right, to the right of the main keyboard, are four keys with arrows. They are sometimes faster to use than the mouse to go to nearby places in the text and add words or correct mistakes. 

[image: image9.jpg]Atk

sessapseenas

CrTrrrryrrrrye
CITTIIIYT -\

‘e o5 78 0 uv)g
e

]




  

[image: image10.jpg]Illﬂ N S 8 =

== K 2 S
[ G T T |
=T 8 S
o ] [ femefnefoe]




  

Return to table of contents
Navigating A Menu 

 Once a program is open, you use the mouse to click on options and selections. When you open MS Word, for example, it is ready for you to begin writing. But if you wish to change the pre-set font, size, or margins, you must go to the menu, click various icons, then click on your selections. Very often you must click on OK after each selection. 

 This is the general principle. Many specifics are best learned by trial and error. Remember that all of the Microsoft Office applications are together in a special file under Programs. When you know the programs well, you can go from one Microsoft Office application to another, and back. 

Return to table of contents
Opening, Closing, And Changing The Size Of A Window 

 The three boxes in the upper right hand corner of the window control sizing. The first minimizes the window, and sets it aside with its title at the bottom of the screen so that you can work on something else and come back to it. The second maximizes the size of the window, so that it fills the whole screen. The third closes the window when you are finished working with it. 

 You can also move the window by clicking and dragging the top, or change the size of the window (if it is not maximized) by clicking and dragging the lower right corner with the diagonal line markings. 

Return to table of contents
Cutting, Copying, Pasting, Inserting 

 When using MS Word and other programs, you can remove or copy a piece of text, or even a graphic image, and insert it in another place. For example, you can take a sentence out of one paragraph and put it into another without erasing and re-typing the sentence. 

 Cutting. Use the mouse to select and highlight the text or image you want to remove. Then go to the Edit menu and select Cut. The material will be removed and stored in the Paste function if you want to insert it in another place. 

 Copying. Do the same as if you were cutting, but select Copy in the Edit menu. The material will not be removed, but will be stored in the Paste function. It can be printed as many times as you want to “paste” it in other places. 

 Pasting. After the material has been cut or copied, it can be pasted into another location by clicking the mouse on the spot where you want to put it, then selecting Paste from the Edit menu. 

 Inserting. You can insert page numbers and other markers by selecting items from the Insert menu. When writing a long paper, it is very handy to have a function that keeps track of page numbers automatically! 

[image: image11.jpg]ft Word
mat  Took Table Window Help

Do e ahz | g mE G o-o- | @BOE
(Er ESTT S SN
and o o1 o|B 2

=81

Type aquestin for help 5]/

@& g e -,

2 i
Office Cipoard = =

&
B

N|

cer 5

SdedAlcukAJis open. you use the mouse fo click on options and
e e ppen MS Word, for example, it is ready for you to
00 e, con DU Wish to change the pre-set font, size, of MArgins.
Y8 . cume M. click various icons, then click on your selections.
Vil - lick on OK after each selection.

al principle. Many specifics are best learned by trial
and error. Remember that all of the Microsoft Office applications are
together in a special file under Programs. When you know the programs

ECEETN|

D= [y | auoshepes= N\ % 1O B 4l 22 A BE.

well, you can go from one Microsoft Office application to another, and back.

N

tn14 Col 1 REC TRK ET OV QX

Page 10 Sect o7 A3

st S OB EBE 14 3% Floppy (1) [ 1 Basic rechniques -

[« 1zzm



  

(Menu for MS Word program with Edit open) 
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Saving Work And Accessing It Later 

 The easiest way to save your work is by having your own floppy disks. The teacher also has a class file on the lab’s network that allows each student in the class to save work there. 

 To save, go to the File menu and select Save As. This allows you to choose a name you will give to the file, and the place where it will be saved (generally, “3 ½ floppy” or the network file). When you are sure it will be saved in the right place, click Save. Be sure your name appears somewhere on the document, and preferably in the name of the file as well. 

 To access later, double click on the My Computer icon on the desktop. It will show the floppy disk drive and other places for saving. Click on the appropriate icon and look for your document. 
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Printing 

 In the lab, there is a single printer for all of the computers. When you are ready to print, click the Print function under the File menu. Then go to the printer and check to see that your work is ready to transfer to the computer used with the printer. If you don’t see it, click Refresh on the printer’s computer. 
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USING MICROSOFT WORD 
Log On 
(1)  Press Ctrl-Alt-Delete 

(2)  Follow log on procedure (see Pg. 4) 

 (3)  Press Enter 
Open Microsoft Word 
 (4)  Click Start 

 (5)  Click All Programs 

 (6)  Click Microsoft Office 

 (7)  Click Microsoft Word 

 (8)  Click the X in the upper right to remove side window 

Make A Document 
(9) Type your assignment. Remember: The program changes lines         automatically. You don’t have to hit Enter unless you want to skip a line. Hit Tab to indent a new paragraph. More detailed instructions follow this section. 

(10)  Save or print your assignment (See section on “Saving Work”) 

Log Off 
 (11)  Click the X box in the upper right corner of the screen 

 (12)  Click No if you don’t want to save your assignment 

(13)  Click Start 

(14)  Click Log Off, then Log Off again
Return to table of contents
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SPECIFIC MICROSOFT WORD SKILLS





To Create A New Document: 
1. Observe insertion point: 

Look for the small blinking vertical line to the left of the paragraph mark. The insertion point is where characters appear when you type. 

2. Enter text 
■Type your name, press Enter. 
■Type your level, press Enter. 

■Type the date, press Enter. 

Type the following text EXACTLY (There is one intentional misspelling). Press ENTER at the end of the title. Do NOT press ENTER at ends of the other lines: 

The Importance of Being Bilingual 
A mother mowse and her baby were running across a floor when they heard a noise. The mother mouse and her baby were frightened, but they stood still, and the mother called out in her loudest voice: “Bow Wow!” It was a cat. The cat ran away. Then the mother mouse turned to her baby and said, “You see, my child, how important it is to know a second language.” 

The insertion point moves as you enter text. Notice words in the paragraph automatically “wrap” (continue on the next line when the end of the line is reached.) 
3.  Make paragraphs 
■Move the I-beam pointer just to the left of the first line of the document. 

 ■Press the TAB key. 

 ■Move the I-beam pointer just to the left of  “The cat ran away.” 

■Press Enter. 

 ■Press the TAB key. 

4.  Correct errors 
■Move the I-beam  pointer just to the right of the “w” In the word “mowse”, then click. 

■Press Backspace to remove the incorrect  character (w). 

■Retype to enter the correct character (u). 
OR, Press the directional arrows on the keyboard until the insertion point appears to the right of the error. 

Then press Backspace one or more times to remove the characters. 

Retype to enter the correct characters. 

To Align Text: 
1. Observe the alignment tools on the formatting toolbar: 
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2. Change the alignment of text: 

■Click to the left of your NAME. 
■Click the align right tool. [image: image20.jpg]


  

When you move the I- beam to a tool on the formatting toolbar, the I-beam becomes an arrow and you can see the name of the tool 
■Click to the left of your LEVEL. 

■Click the align right tool. 

■Click to the left of the DATE. 

■Click the align right tool. 

■Click to the left of the TITLE. 

■Click the center tool. [image: image21.jpg]


  

To Highlight Text: 
1. Highlight one word 
■Double-click the word. 

The space after the word is also highlighted 
■Double click your first name. 

2. De-select highlighted area: 

■Click anywhere in the text. 

Your name is no longer highlighted, and the insertion point is positioned where you last clicked. 
3. Highlight a block of text. 

■Put the I-beam pointer to the left of the TITLE. 

■Click to place the insertion point. 

■Hold down SHIFT. 

■Click to put the insertion point after the last word in the TITLE. 

To Apply Line Spacing: 
Double-space paragraph lines: 
■Click inside the paragraph. 

■Click the double space button on the formatting toolbar. 
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To Change Fonts And Font Sizes: 
    1.  Check current font and size of text 
■Click inside of any word or line, or Highlight any text. 

■Click the first word in the TITLE. 

■ Look at font name and size on formatting toolbar. 
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The toolbar shows the name and size of the font used for the text. 
2. Change the font 
■Highlight the TITLE. 

■On the formatting toolbar, click the down arrow   [image: image25.jpg]


    next to the font name to see the font list. 

■On the font list, choose a font. 

3.  Change the size:  
■Highlight the TITLE. 

■On the formatting toolbar, click the down arrow   [image: image26.jpg]


   next to the current font size. 

■On the font size list, choose a font size. 

To Apply Font Styles: 
1. Add a single style to text: 
■Highlight any text, then on the formatting toolbar, click the Bold Tool  [image: image27.jpg]


 

The text appears in bold type. 

 ■Highlight “Bow Wow.” 

■Click the Bold Tool.  [image: image28.jpg]


 

2. Remove the same style. 
 ■On the formatting toolbar, click  [image: image29.jpg]


   . 

The formatting tool is like an on/off switch, so the style is removed when you click on it again. The orange highlight on the tool tells when it is on. 
3. Add styles one at a time 
■Highlight the TITLE.  

■On the formatting toolbar, click [image: image30.jpg]


  . 

■On the formatting toolbar, click the italic tool [image: image31.jpg]


   

■On the formatting toolbar, click the underline tool  [image: image32.jpg]


  

All three tools now have light highlight 
■Click outside the TITLE to de-select it and see the styles. 

4. Remove styles one at a time 

. 

■Highlight the TITLE. 

■Click the bold tool, the italic tool, and the underline tool. 

■Watch the text change back to normal styles. 

To Cut, Copy, & Paste (Move text to another place):  
■Click just to the left of “It was a cat.” 

■Highlight “It was a cat.” 

■Click the copy tool on the standard toolbar. [image: image33.jpg]


  

■Click just to the right of the word “noise.” 

■Click the paste tool on the standard toolbar. [image: image34.jpg]


  

Now there are two copies of “It was a cat”  
■Click just to the left of the SECOND “It was a cat, & highlight it. 

■Click the cut tool. [image: image35.jpg]


 . It is now removed again. 
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